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File 
The File menu is where all file related operations are 

accessed.    The options are:
(Hit Page PgDn for more information)

Note:    When Kid Mode is turned on some of the options below are substituted for 
another, See Kid Mode On/Off  for more details.

New
This option returns the user to a blank screen with no file association.    It is in effect a

complete start-over option.

Open...
This menu option starts a dialog box for the user to choose a bitmap (*.bmp) file to 

open.    ColorBook also will open most Run Length Encoded bitmap files (*.rle).

Open Coloring Book...
This is ColorBook's coloring book option.    Choose this option to bring up a dialog box 

with drawings to color.    To open a picture, select a picture with the left mouse button and 
then press the OK button.    A shortcut is to double-click the picture you wish to open.

Save
This option saves a picture in bitmap format (*.bmp) in a file whose name is listed in 

the window title.    Please observe that only filenames of the form cbx.bmp, where x is a 
number, will be noticed by ColorBook's coloring book feature.    See the option File|Add 
Picture to Book  for more details.

Turn off File Compression to save in a format recognized by Paintbrush!!

SaveAs
This option saves a picture in bitmap format (*.bmp) in a file with the name you type 

into the dialog box.    Note that when Kid Mode is off you can choose the filename in which to
save the picture.    If Kid Mode is on then both File|Save and File|SaveAs are identical to the 
File|Add Picture to Book option described below.    See option File|Save above for more 
details.    

Turn off File Compression to save in a format recognized by Paintbrush!!

Add Picture to Book
This option adds the current picture to the coloring book.    This picture may then be 

used over and over again.    There is a limit of 40 pictures that may be saved using this 
option. The user must delete an existing picture in order to save a new picture after the limit
of 40 is reached.

Print
This is the option to print the current picture.    ColorBook does print in color when 



attached to a color printer.    The picture is changed to monochrome shading when attached 
to a monochrome printer.

Turn off Kid Mode to Print!!

Quit  
Choose this option to exit ColorBook.    Remember to save your work!!!



Edit 
The Edit menu is where all editing related operations 

are accessed.    The options are:
(Hit Page PgDn for more information)

Cut
This option is identical to the File|New option except that it puts the existing picture 

in the Windows Clipboard.

Copy
This option puts the current ColorBook picture into the Windows Clipboard.    Use this 

option to move your ColorBook pictures to other programs.

Paste
This option takes the contents of the Windows Clipboard and puts it on the ColorBook

picture window.    ColorBook expands/shrinks the clipboard image as needed to fill the entire 
ColorBook picture window.

Clear Screen
This option clears the ColorBook picture window.    File name associations are 

unaffected.

Uncolor Picture
This option removes the color from the current picture.    This option may be used 

before adding a picture to the coloring book because it reduces the file size needed to store 
the picture.    

NOTE: This procedure may take a few minutes,    this is the price ColorBook pays to 
accurately uncolor a picture.



Options 

The Options menu is where all advanced operations 
are accessed.    The options are:
(Hit Page PgDn for more information)

Kid Mode
This option is intended to allow un-supervised use of ColorBook by new Windows 

users.    This option is the default option and is turned on when ColorBook is started.

Kid Mode keeps the ColorBook picture window maximized in order to discourage the 
user from switching to another application and inadvertently destroying important files or 
data.    This option may be disabled by choosing this option from the menu or by using the 
shortcut key sequence ALT-k.

See Kid Mode On/Off for more details.

Sound Effects
This option toggles the sound effects on and off.

Text in Current Color
This option allows the text placed by the text option to be the current color.

Change Text Font
This option allows the font to be changed from a dialog box.    All Fonts installed into 

Windows are available to ColorBook.

Lines in Current Color
This option allows lines to be drawn in the current color as indicated by the current 

color box in the upper left corner of the canvas.    The current color Box is the region of Blue 
in the picture below.

Choose Line Width and Color...
This option brings up a dialog box from which the line width and color may be 

changed.

Draw Color-Filled Objects
This option allows you to draw objects with interiors filled with the current color.



Allow Coloring with Black
This option allows coloring with the color BLACK.    In normal operation ColorBook 

does not allow this color to be used because the borders of the pictures are black.    If the 
user changes the border color then the coloring feature will not work correctly.

Warning!!!: this option when activated may result in unexpected behavior.    Be sure to save 
your work before activating this feature!!!!!!!!

Make Your Own Color...
ColorBook comes with 54 pre-defined colors.    However, the user may want to mix 

their own custom color and replace a pre-defined color.    By using this option the user can 
re-define all 54 colors if desired.

The custom colors are not saved when the user quits ColorBook.

Restore Colors to Default
This option restores all 54 top menu colors to the pre-defined default.    See the 

Choose Custom Colors... option for more information.
 
File Compression

This option turns file compression on and off.    Picture files are compressed when the 
check mark appears by the menu item.    This is included because Window's Paintbrush can 
not read a compressed file.    Therefore, to save a file in Paintbrush format turn file 
compression off.



Help 
The Help menu is where instructive information is contained. 

The options are:

Contents
This option is the option your are now using.    It may be invoked at any time by pressing the 
F1  function key.

Help on Help
This option invokes Window's instructions on how to use the HELP utility.

More Coloring Books from MES
This item prints an order form containing ordering information for additional coloring books 
for this program along with ordering information about other products from MES.

View description of other MES software...
This option invokes Windows WRITE editor with a file containing descriptions of other 
educational software available from MES.    Remember to exit WRITE before returning to 
ColorBook.

About ColorBook
This option brings up a dialog box with the current version number.



Add to Coloring Book
ColorBook comes with one 40 page coloring book of pre-drawn images.    These 

images are in such a form as to be unchangeable by the user.    That is why ColorBook allows
for an additional 40 images to be added in a second book by the user.

This is accomplished by choosing Add Picture To Book from the File menu.    ColorBook
will take the current picture on the screen, create a miniature image from the it and save 
both the normal size and miniature images to your disk drive.    At one point during this 
process you will need to press the OK button on a preview of the miniature image.

There is no option to abort this procedure during the preview.    However, if you 
change your mind you may delete the coloring book entry from the Coloring book dialog 
window.

For Best results you may wish to un-color the picture before you add the picture to 
the coloring book.



Change Colors
The color selections may be changed one by one if the user wishes to have a shade 

not included in the original selections.    This is accomplished by choosing the Options|Make 
Your Own Color item from the options menu.    Then place the mouse cursor over the color to 
change.    Press the right mouse button to bring up a dialog box in which a custom color may 
be mixed.    Press the OK button to replace the old color with the new color.      To turn off this 
option choose Options|Make Your Own Color so this menu item appears unchecked.

Note these custom colors exist only for the current session, when ColorBook is exited 
all previous custom colors are lost.



Re-Coloring Pictures
Changing the color of a picture is the purpose of ColorBook.    In this respect 

ColorBook has a great advantage over traditional paper coloring books.    To change a color 
from the existing color to another color merely select the new color, choose the crayon tool, 
place the tip of the floating crayon on the color to change, then press the left mouse button.



Delete a Picture
Only user-drawn pictures may be deleted!    To delete a user-drawn picture select 

Open Coloring Book either with the open book icon in the side menu or from the file main 
menu.    Select a user-drawn picture by single-clicking on the miniature icon and then select 
the delete button in the bottom of the dialog box.    You will be prompted to confirm deletion 
of the file.    Choose OK to delete the picture or Cancel to not delete the picture.    The dialog 
box will then redisplay itself to reflect the deleted item.



Export through the Clipboard
To include images from ColorBook in your other Windows programs you may use the 

Windows Clipboard.    This allows you to take the entire drawing area (excluding the top and 
side menus) and paste it into other programs such as your favorite word processor, etc.    
ColorBook exports both device dependent and device independent bitmaps when this option
is chosen.

To export a picture that is currently in the ColorBook picture window choose Edit|Copy
from the Edit main menu.    Then switch to the program where you want to place the picture 
and choose Paste from that program's edit menu.



Import from the Clipboard
To include images from your other Windows programs in ColorBook you may use the 

Windows Clipboard.    This allows you to take images from other painting programs or any 
other Windows or DOS program that displays an image and import it into ColorBook for 
alteration and/or saving.    ColorBook will import both device dependent and device 
independent bitmaps.

To transfer an image from a DOS program to ColorBook you must display the DOS 
program in a Window.    Then choose Edit|Mark from the Corner Window Menu and use the 
mouse to select the image.    Then choose Edit|Copy from the DOS programs corner menu.    
After this is done switch to ColorBook and Choose Edit|Paste.    This will take the contents of 
the Clipboard and stretch/shrink it so that it fits ColorBook's picture window exactly.    By 
turning Kid Mode on or off the user can re-size an image by experimenting with the 
ColorBook Window size that produces the desired result.      



Kid Mode On/Off
Kid Mode is a feature that keeps the ColorBook window full-sized to discourage small 

children from tampering with important programs and/or data.    To toggle this feature on or 
off choose Options|Kid Mode from the options menu or use the accelerator key sequence 
ALT-k.    A message dialog box will inform you whether Kid Mode is on or off, hit the return 
key or click the OK button to dismiss the message dialog.

In addition to the above features, Kid Mode also alters some entries in the file main 
menu to simplify the use of ColorBook for new users.    Below is a description of the file menu
when Kid Mode is on:

Print is disabled, turn Kid Mode off to print.
Open Coloring Book is substituted for New and Open.
Add Picture to Book is substituted for Save and SaveAs.

Turning Kid Mode off will return the menu to normal operation.



Open Coloring Book
To open the coloring book click the book icon at the bottom of the side menu or 

choose File|Open Coloring Book from the main menu.    Either operation brings up a dialog 
box containing miniature images of the pages.    To color one of these pictures select it and 
then the OK button at the bottom of the dialog.    You may also double-click the picture you 
wish to color and it will be opened.

To access the user drawn coloring book select Next Book.    To return to the original 
coloring book just select Next Book button again.    In this manner you can swap from one 
book to    another.

This version of ColorBook has been programmed to accept and manage up to 10 
coloring books with no additional updates except for the purchase of additional coloring 
books.    Contact MES for availability.



Place Text on Picture
To place text on the picture select the 'A' icon near the bottom in the side menu.    A 

dialog box will appear with a place to type the text into.    The backspace key allows you to 
correct mistakes if needed.    After typing the text choose the OK button to dismiss the dialog
box.    The cursor will change to an 'A' when the cursor is over the picture window.    Press 
and hold the left mouse button and a floating rectangle will appear in the size required to 
hold the text.    Release the mouse button to place the text where the rectangle is positioned.

To change the font choose Options|Change Text Font...    from the options menu.



Print Current Picture
ColorBook has the ability to print what the user colors.    If a color printer is available 

ColorBook will print in color.    ColorBook will operate with most any printer that can be 
installed in Windows.    In the case of a monochrome printer ColorBook will translate colors 
other than black to a gray shading pattern when printed.

An interesting use of ColorBook is that you may print the un-colored images so the 
pictures may be colored with real crayons.

Note:    Kid Mode must be turned off in order to print!



Sound Effects On/Off
ColorBook provides simple sound effects for entertainment.    The sound effects may 

be turned off by selecting the speaker tool or by choosing the Options|Sound Effects from 
the main menu.    When sound effects are on, the speaker tool is inverted so that the status 
of the sound effects may be seen at one glance.



Coloring Books 
ColorBook comes with one 40 page coloring book of pre-drawn images for your 

coloring pleasure.    In addition ColorBook provides for a user drawn 40 page coloring book as
well.

The ColorBook drawings were drawn by hand by Evelyn White and later scanned into 
electronic format.    Ms. White is a public school Art instructor in Tazewell TN who also has a 
thriving artistic career.    She works in calligraphy, oil painting and freelance art from her 
studio.    If you would like to see more of Ms. White's artistic work write to:

Evelyn White
1508 Tazewell Rd.
Tazewell, TN 37879
ph (615) 626-9106

Also see:
Help|More Coloring Books from MES



Coloring Books and Other Educational Products 
From MES 

ColorBook comes with one book of 40 pictures to color.    MES supplies additional 
coloring books for your coloring pleasure.    At this time two additional coloring books are 
available, this number may increase in the future. For ordering information    print out the 
order form by selecting the Help|More Coloring Books from MES menu item located in the 
help menu.

In addition, MES offers educational software for both DOS and Windows 
environments.    To view a brief description of the software available at this time choose the 
Help|View Description of Other MES Software... menu item.

You may write to MES at the following addresses:

U.S. Mail: Motes Educational Software
P. O. Box 575
Siloam Springs AR, 72761

Electronic Mail: 73757,1111              on CompuServe

or from Internet 73757.1111@compuserve.com 




